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Action Info User Guide – Introduction
1. Getting Started
Access your favorite mobile brands with 80% less keystrokes and 20x faster 
response times than with a mobile browser. 

Action Info™ is a suite of nine interconnected applications that learn and 
remember a user's favorite cities, restaurants, airports, and more - getting more 
personalized after each use.

Go shopping on Amazon.com, check your eBay bids, get scores on FOX Sports, 
locate restaurants on Restaurant Row.com, check movie times with Zap-2-It, get 
driving directions using Microsoft MapPoint, read your local news and manage 
your stocks with Associated Press News and Stocks, and get your local weather 
forecast from AccuWeather.com - all on your device.

INTRODUCTION

This User's Guide will give you the information you need to set up, configure, and 
use Action Info.
5
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TYPOGRAPHIC CONVENTIONS

This guide uses the following typographic conventions:

NOTE: Notes provide additional information or cautions.

ACTION INFO OPERATING REQUIREMENTS

The following are the minimum recommended requirements for installing and 
running Action Info:

• A device running one of the following software operating systems:
• Windows Mobile 5.0 for Smartphone and Pocket PC Phone Edition
• Windows Mobile 2003 or 2003 Second Edition for Smartphone and Pocket 

PC Phone Edition. 
• 2MB of available device memory (RAM)

REMOVING ACTION INFO FROM YOUR DEVICE

Be sure to remove any previous installations of Action Info before installing a new 
version.  To remove a previous installation:

1. On your device, go to Remove Programs: select 
Start>Settings>More>Remove Programs

2. Select Action Info.
3. Select Yes at the Confirmation screen.  Your device will remove Action Info.
4. Restart the device to remove any remaining files.

Convention Explanation Example

 Bold Indicates Graphical User 
Interface elements.

Press Go to load the User 
Details window.

Courier New Indicates code samples, 
screen display, or 
network and file paths.

//Admin/Device Support/
Users/Address

Courier New 
Bold

Indicates user input, 
contrasted with on-
screen output.

Enter User Name: johndoe

Italics Indicates book, section, 
and software titles.

Refer to the Create New User 
section.

<ItalicType> Indicates variables to 
be replaced with the 
user’s values. 

Enter <DeviceName>

> Indicates menu and tree 
hierarchy.

To open a new document, go 
to File>Document>Open
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2. Starting Action Info
To begin using Action Info, you must first create an account. Your account will 
keep track of your preferences, favorites, and previous searches and results.

CREATING A NEW ACCOUNT

1.  Start the Action Info client.
 

7
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2. At the Log On screen, select the Don't have an account? link.

3. Start the Sign-up process by selecting Send.
4. Enter the following information for your account:

• Your First Name
• Your Last Name
• A unique Username
• Your Password and password confirmation

NOTE: Passwords must me a minimum of 6 characters in length.

• A password hint to help you remember your password
• An active E-mail address
• Your Phone Number
• Your Authorization Code (you should have received your authorization code 

in an e-mail from Handango.  If you did not receive an authorization code, 
contact Action Info support at actioninfosupport@actionengine.com)
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Select Next to register your account.

NOTE: If the username you have entered is already in use, you will be prompted to enter 
a different username.

5. Action Info will display the following message:

Verify you are over the age of 13 by selecting Yes.

6. Accept the End User Licensing Agreement and select Next.
7. Once your user account has been created, log on using the account informa-

tion that was created above.

Log On
1. To log on, enter your User Name and Password in the appropriate spaces.

The remember password box can be checked for ease of use when logging 
on in the future. 

2. Select Send.
9
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OVERVIEW OF THE USER INTERFACE

Navigating Action Info
Action Info provides an intuitive user interface. There are several different ways to 
navigate through the applications.

Figure 2-1: SmartPhone Navigation
• Use the number keys to select applications, menu items, or options within the 

application.

• Use the Navigation Pad to highlight applications, menu items, or options 
within the application and the Action Key to select the highlighted item.

• Use the Soft Keys to navigate through screens. 

• The Left Soft Key moves to the next screen or sends the request to the 
server. 

• The Right Soft Key opens the System Menu.

• Use the Back Key to go back a screen or to erase characters in a text box.

Navigation Shortcuts
To return to the Home screen from any point in the application:

• Select the Home icon on the button bar
• press the Right Soft Key to open the menu and select option 9 Home.

To exit Action Info from any screen in the application, press the Right Soft Key to 
open the menu and select 5 Options > 9 Exit.

Right Soft Key: 
Opens the System 
Menu.

Left Soft Key: 
Advances to the 
next screen or 
sends the request 
to the Server.

Home screen: 
Displays the nine 
applications in the 
Action Info pack.

Item Number: 
Press the 
corresponding 
number key to 
select this option.
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3. Using Action Info
INTRODUCTION

This chapter describes how to use the various features of Action Info.

MENUS

The Platform menus allows you to perform a number of different operations and 
configurations.
11
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SmartPhone System and Options Menus

Figure 3-1: SmartPhone Main System Menu and Options Menu
The items in the main System Menu are:

• Previous – Returns to the previous screen in the application.
• Next – Advances to the next screen in the application.
• End – Advances to the last screen in the application.
• Actions – Allows you to save your results to either your local device or the 

network, e-mail your results using the e-mail application, edit your original 
request, or delete the current results. The items in this menu item will change 
depending on where you are in the application.

• Options – Displays the menu items listed in the Options Menu Items section 
below.

• My Request – Displays your current request.
• My Result – Displays your current result.
• Home – Returns you to the main Action Info screen.

Options Menu Items
The items in the Options menu are:

• Results – Displays your recent results.
• Requests – Displays your recent requests.
• Outbox – Displays requests that have been attempted but not completed. 

When you returns to the Action Info home screen, you will be prompted to look 
at the Outbox if there are any pending requests.

• Synchronize – Allows you to synchronize your results and favorites with the 
network.

• Favorites – Allows you to browse and edit your favorites.
• Settings – Displays the Settings screen to adjust your Action Info options
• My Account – Displays account information for your Action Info account.  For 

additional information, refer to the My Account section below.
• Log On – Allows you log on to Action Info using your User ID and Password. If 

you are currently logged on, this will display Log Off and your user name.
• Exit – Exits Action Info
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BUTTON BAR

When your results are returned from the server, Action Info may display the 
button bar at the bottom of the screen. This bar displays a row of icons to allow 
you to save the results, send the results using your phone’s e-mail or SMS, add 
the results to your contacts or your calendar, or download a map for the results.  
Depending on your result, not all of the icons will display.  To show or hide the 
Button Bar, press the * key (SmartPhone only).

MY ACCOUNT

The My Account application allows you to keep track of your account’s information 
including:

• First and Last Name
• User Name
• Password and Password Hint
• E-mail Account associated with your user account
• Account Status, including your subscription expiration date

Access the My Account application by either selecting the Account icon on the 
Action Info Home Screen, or by opening the System menu and selecting 
Options>My Account.

Save the result 
to your device.

Send the result 
using either e-
mail or SMS

Add the result to 
your contacts.

Add the result to 
your calendar

Download a map 
of the result

Return to the 
Action Info home 
screen
13
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To change the information for your account, tap the link corresponding to the 
information you would like to change and enter the new information.

If you are using a trial version of Action Info, select Purchase to register your 
version of Action Info.  You will be re-directed to the Handango website to enter 
your credit card information and you will receive an authorization code via e-mail.  
Once you receive the code, tap the here link on your My Account page and enter 
the authorization code.  Your version of Action Info will now be valid for one year.

DIALING RESULTS

When results received from the server include contact information, you can dial 
the contact directly from the results screen.  To dial a contact:

To view or change 
your account 
information, select 
the appropriate link.

Select the Purchase 
button to buy a one-
year subscription to 
Action Info

Select the here 
link to enter your 
authorization code.

For technical support, e-mail 
actioninfosupport@actionengine.com
 or visit the wesite at 
http://www.actionengine.com/actioninfo.

mailto:actioninfosupport@actionengine.com
http://www.actionengine.com/actioninfo
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• Select the phone number in the contact information returned in your results. 
Your phone will automatically dial the contact.
15
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SAVING RESULTS

Results received from the server can be saved onto your device for later review or 
to the network to be synchronized to another device. Saved results are viewed by 
selecting Results. To save your results:

• Select the disk icon on the button bar.

• Open the System Menu and select Actions> Save

FORWARDING RESULTS

Results received from the server can be forwarded to one or more addresses using 
the messaging program on your device. The results are included as content in the 
body of the message. To forward your results:

• Select the mail icon on the button bar.

• Open the Action Menu and select E-mail Result.

FAVORITES

When you use a service, Action Info remembers some of the information you enter 
so you can simply re-use it rather than re-enter it the next time you use the 
service. Action Info can also share that information between services. If you are 
using a service that provides driving directions from Redmond to Seattle and then 
look up restaurants, Action Info can anticipate that you want to find a restaurant 
in Seattle. You can also manually add favorites and give them friendly names to 
make using them easier.

To view a list of your favorites or to create a new favorite, open the System Menu 
and select Options>Favorites.  Action Info will display a list of favorites 
categories that you have favorites defined for.

To view existing favorites:

• Select the desired favorites category.  Action Info will display a list of existing 
favorites.

To create a new favorite:

1. Open the System Menu and select Favorites.  Select Cities, Airports, and 
Places. Action Info will display the following list of categories:
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• Addresses
• Airports
• Cities
• Zip Codes
• Places

2. Select the category in which you want to add a favorite
3. Open the System Menu and select Actions>Add New Favorite

4. Enter a friendly name for the favorite
5. If desired, check the Expire Favorite check-box and enter a date to set an 

expiration for the favorite.
6. Enter any additional information for the favorite
7. Select the OK icon to save the item to your favorites.

CONFIGURING SYSTEM OPTIONS

The Action Info allows you to configure various system options to customize your 
experience. To customize your system options:

• Open the System Menu and select Tools > Options. Action Info  will display 
the Options screen with the following options:

• General – Sets your preferences for requests, results, and favorites.
• Memory – Set the storage size limit for favorites, saved results, and other 

temporary files. 1MB is sufficient in most cases.
• Connection – Manage your RAS connection.
• Advanced – Specify a different server location.

NOTE: Do not change your server location without contacting your carrier first. Changing 
your server will cause your service to be interrupted.
17
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SYNCHRONIZATION

If you use the Action Info on multiple devices, or on a mobile device and your local 
computer, you can synchronize your favorites and saved results between the 
locations. When viewing your results, The System Menu includes the options to 
save the results locally or save them to the network where they can be 
synchronized on other devices.
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4. Application 
Descriptions

The basic steps for using Action Info are:
 

APPLICATION DESCRIPTIONS

Action Info has a number of applications that can be used. In this section you will 
find information on how to use the application in the most effective manner. You 
will also learn how the applications share data and make the results available 
while offline.
The available applications are:

The following sections describe the basic applications for Action Info.

 1) Select an 
application 

2) Answer a 
few simple 
questions 
offline 

3) Review 
the resulting 
request 

4) Send the 
request 

5) View the 
returned 
results offline 

6) Do more 
with the results 
(e-mail, add to 
calendar, etc.) 

• News
• Weather
• Dining
• Movies
• Directions and Maps

• Amazon Shopping
• Stocks
• Sports
• eBay Bid & Buy
19 
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News
The News feature provides you with nine categories of the latest news stories and 
videos. 

To view a news article:
Select the AP News icon and choose the category of news that you would like and 
select Next. You will be presented with a summary of your request.  Click on the 
information in your request to change your choices before sending. 

Select Send to continue.

You will be presented with a list of news articles. Select the headline of your 
choice to view the full article.

Once the article is downloaded, select the mail icon to e-mail the article in text 
format or select the save icon to save the article to your device.

To view AP Videos:
Select AP Videos and select Send.  You will be presented with a list of current 
news videos.

Select Next to 
advance to the 
next screen.
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Select the desired video and Action Info will display a summary of the news video 
with a link to download the video.

Select the link and the video will be downloaded to your device and opened with 
the default media player.

Weather
The Weather application will give you current conditions and a five day forecast for 
the location that you specify. 

To receive a weather forecast:
Select the Weather icon and choose whether you would like to specify your 
location from a contact, select a city from the list of cities, or enter a custom 
location.  

If you choose Select a City or Enter a Location, you will be prompted to specify 
what region you would like.  If you select the Don’t ask me again check-box, 
Action Info will remember your preference.
21 
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Once you have selected your location, Action Info will display a summary of your 
request.  Select Send and Action Info will display weather information for the city 
selected.

Dining
The Dining application allows you to find a restaurant either by entering the 
restaurant’s name or by selecting a type of cuisine and Action Info will display a 

Select the Don’t ask me 
again check-box and Action Info 
will remember your preference.

Action Info remembers 
locations from your 
previous requests.
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list of restaurants near your location that specialize in the selected cuisine.

To find a restaurant, select the Dining icon and on the main Dining page select 
Find a Restaurant.  You will be given the option to either:

• Enter a Restaurant Name to find the location of a restaurant

-OR- 

• Select a Cuisine to find a restaurant specializing in a specific type of cuisine.

Find a restaurant by restaurant name
If you choose Enter a Restaurant Name, you will be prompted to enter some or 
all of the restaurant name and the location of the restaurant (enter an address, 
city, or select an address from your contacts). 

Once you have selected your location, Action Info will display a summary of your 
request.  Select Send

Select Next to 
advance to the 
next screen.

Select Next to 
advance to the 
next screen.
23 
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Action Info will return a list of restaurants with names matching the information 
you entered.  Select the desired restaurant and Action Info will display the details 
of the restaurant.

Find a restaurant by cuisine type
If you choose Select a Cuisine, you will be presented with a list of cuisine types.  
Select the desired cuisine and select Next to enter the location of the restaurant

Select any item in your 
request to change your 
choices before sending.

Select the phone number in the 
results to call the restaurant 
from your device.

Action Info remembers 
locations from your 
previous requests.
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Once you have selected your location, Action Info will display a summary of your 
request.  Select Send and Action Info will return a list of restaurants with names 
matching the information you entered.  Select the desired restaurant and Action 
Info will display the details of the restaurant.

Movies
The Movies application allows you to search for theaters near your location and 
find out what movies are currently playing at that theater. 

To locate a theater:
Select the Movies icon and choose whether you would like to specify your location 
from a contact, select a city from the list of cities, or enter an address.  

Select the phone 
number in the results 
to call the restaurant 
from your device.

Select the Cities button to 
select your city from a list 
of cities.
25 
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Once you have selected your location, Action Info will display a summary of your 
request.  Select Send

Action Info will display a list of theaters for the area you selected.  The theaters 
are sorted by distance from your location, with the closest theaters listed first.  To 
view the movies playing at a theater, select the theater name.

For each movie, select the Get Details link to view additional information about 
the movie.

Select the phone 
icon to call the 
theater.

Select Get Details 
to view a summary 
of the movie details.
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Directions
The Directions application can be used to map a location or address or to get 
driving directions between two locations. Locations can be input from a contact, 
airport, city, address, or a previously used location.

To get driving directions:
Open the Directions application and select Get Driving Directions.  Action Info 
will prompt you to choose what region you are in.

Scroll down and select Full 
Details to view the complete 
information about the movie.

The Back to Results link 
returns you to the list of 
theaters generated by your 
request.

Select each link to 
view additional 
information about the 
movie.
27 
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Select your region and select Next.

Enter your starting location. You can select a contact, an airport, a city, enter an 
address, or enter the name of a local landmark.

Once you have entered your starting location, select Next and enter your 
destination.  As with the starting location, you can select a contact, a city, an 

Select the Don’t ask me 
again check-box and Action Info 
will remember your preference.

Select Next to 
advance to the 
next screen.

Action Info remembers 
locations from your 
previous requests.
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airport, enter an address, or enter the name of a local landmark.  Select Next to 
continue.

Once you have entered your destination, select Next and select whether you 
would like your directions in kilometers or miles and whether you would like the 
shortest route or the quickest route.

Action Info will display a summary of your request. To change any items, select 
the item you wish to change. If you are satisfied with the request, select Send.

Once the request is processed, Action Info will show your driving directions with 
the option to go through a step-by-step process or view a map.

Select the Don’t ask me 
again check-box and Action Info 
will remember your preference.
29 
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To get a map of a location:
Open the Directions application and select Map a Place.  Action Info will prompt 
you to choose what region you are in.

Select your region and select Next.

Enter your starting location. You can select a contact, an airport, a city, enter an 
address, or enter the name of a local landmark.

Select the map icon view a map of 
your driving route or select the 
directions icon to view step-by-step 
directions to your destination.

Select Next to 
view the next step 
of your directions.

Select Next to 
advance to the 
next screen.

Select the Don’t ask me 
again check-box and Action Info 
will remember your preference.
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Once you have entered your destination, select Next.

Action Info will display a summary of your request. To change any items, select 
the item you wish to change. If you are satisfied with the request, select Send.

Action Info remembers 
locations from your 
previous requests.
31 
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Once the request is processed, Action Info will display your map.

Shopping
Action Info allows you to browse and purchase items from Amazon.com®.  
Through the Shopping application, you can:

• Browse Amazon.com’s categories for items.
• Search for items using keywords, UPC or ISBN codes, or by defining 

parameters to identify the item you want.
• Create a shopping cart to keep track of items you want to purchase.

To browse Amazon.com’s Categories:
Select the Shopping icon and select Browse.  Action Info will display a list of 
Amazon.com’s categories

Select Zoom to 
increase or decrease 
the area shown.

Select Pan to move 
the map within the 
application window.

Select Legend to view 
an explanation of the 
symbols used in the map.
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Select the category and sub-category your would like to browse.  Action Info will 
display a summary of your request.  To change any items, select the item you 
wish to change. If you are satisfied with the request, select Send.

Action Info will return a list of items in your selected category.  To view more 
information about an item, select the desired item and Action Info will display the 
details for your item.

Select the name of 
the item you would 
like to view.
33 
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Searching for an item:
Action Info provides three different methods for searching for a specific item on 
Amazon.com:

• Power Search – Action Info allows you to narrow your search based on a 
category, genre, and keyword or phrase.

• Keyword Search – Define a keyword or phrase to search in all of 
Amazon.com or in a specific category.

• UPC/ISBN Search – If you know the Universal Product Code (UPC) or 
International Standard Book Number (ISBN), you can search for the item 
using the UPC or ISBN code.

Scroll down to view 
more information for 
this item.

Select the Used 
From link to find 
used copies of this 
item to buy.

Select actor’s name 
to find additional 
items with this actor.

Select the View Cart 
link to view the items 
currently in your 
shopping cart.

Select the Add to Cart link or the 
shopping cart icon to add this item to 
your shopping cart for purchasing.  For 
more information about your shopping 
cart, refer to the shopping cart section 

Read customer 
reviews of this item 
by selecting the title 
of the review.

Select the Similar 
Products link to find 
items similar to the 
item you are viewing.
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To power search:

Select Power Search.  Action Info will display a list of categories.  Select a 
category and genre (or sub-category for Manufacturer).  Enter a keyword or 
phrase and select Next.

Action Info will display a summary of your request.  To change any items, select 
the item you wish to change.  If you are satisfied with the request, select Send.

To search by keyword:

Select Keyword Search.  Enter a keyword or phrase and select a category to 
search in, or enter All to search all of Amazon.com.

Action Info will display a summary of your request.  To change any items, select 
the item you wish to change.  If you are satisfied with the request, select Send.

To search using a UPC/ISBN code:

Select UPC/ISBN Search and select whether you would like to search using a 
UPC code or an ISBN code (for books only).  Enter the code and select Next.  If 
you are using a UPC code, you can search in a specific category by selecting Area.

Action Info will display a summary of your request.  To change any items, select 
the item you wish to change.  If you are satisfied with the request, select Send.

Viewing your search results:

Once your search is complete, Action Info will return a list of results that match 
your search criteria.
35 



Action Info User Guide – Application Descriptions

36
Using your Shopping Cart:
Action Info will maintain a shopping cart of items you wish to purchase.  To add an 
item to your shopping cart, select the Add to Cart link or the shopping cart icon 
on the item’s details page.  Action Info will display the following confirmation:

Once you have added an item to your shopping cart. you can continue shopping 
and add additional items to your shopping cart.

You can view the items in your shopping cart by selecting View My Cart from the 
shopping application home page.

Select the name of 
the item you would 
like to view.
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Once you have all your items in your cart, select Check Out on your Shopping 
Cart page.  Action Info will display the following confirmation in your device’s 
browser:

Select Continue and Action Info will redirect you to Amazon.com’s mobile site to 
complete the checkout process.

For more information about completing your transaction, refer to Amazon.com’s 
website.

Select the Check Out link 
to go to the Amazon.com 
site and pay for your 
items.

Select the Remove 
Item from Cart link 
to delete the item.
37 
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Stocks
The Stocks application displays 15-minute delayed stock quotes, lookup a stock 
symbol for a company, or get current market information. The application also will 
track your portfolio and maintain a list of your stocks.

To get a stock quote:
Select the Stocks icon and select Stock Quote.  You may enter up to six stock 
symbols.

Once you have entered your stock symbols, select Next. Action Info will display a 
summary of your request.  To change any items, select the item you wish to 
change. If you are satisfied with the request, select Send.

Action Info will display a quote summary for each symbol you entered.  For 
additional information about the stock’s performance, click the Details link.

Select Next to 
advance to the 
next screen.
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To find a company’s ticker symbol:
Action Info allows you to look up a stock’s ticker symbol by entering all or a part of 
the company’s name or symbol.  

Select the Stocks icon and select Symbol Lookup. Select whether you want to 
find the symbol by using the ticker symbol or the company name.

Select Search Type allows you to specify how Action Info will return results 
using the criteria you define:

Select Details to 
view additional 
information about the 

Select Chart to 
view a chart of the 
stock’s performance.

Select News to view 
news articles relating 
to the company.

To change the scope of 
the chart, select the 
desired time-frame link.

Select Next to 
advance to the 
next screen.
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• Begins With... – Action Info will only return results that start with the 
information specified

• Contains... – Action Info will return results that contain the information 
specified anywhere in the company name or symbol

• Ends With... – Action Info will only return results that end with the 
information specified 

Select the search type and select Next.  Enter your search criteria in the text box 
and select Next.  Action Info will display a summary of your request.  To change 
any items, select the item you wish to change. If you are satisfied with the 
request, select Send.

Action Info will return a list of companies that match your search criteria.  To view 
additional information about a company, select the company name.

Select Next to 
advance to the 
next screen.
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Tracking your portfolio with Action Info
Action Info allows you to track detailed information about the stocks in your 
portfolio.  Select the Stocks icon and select My Portfolio.  Action Info will display 
your current portfolio along with current quotes for the Dow Jones Industrial 
Average and the Nasdaq Composite Index.

To add stocks to your portfolio, select Add Stocks.  You can enter the following 
information for up to six stocks:

• Stock Symbol
• Your stock purchase price
• The total number of shares
• A description of the stock

To view quote details 
for this company, 
select the Quote 
button.
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Once you’ve added all your stocks, select Next.  Action Info will add the stocks to 
your portfolio and begin to track your portfolio’s value.

To view market highlights
Action Info will display the latest market highlights including:

• A summary of the market activity for the day
• A list of the most active stocks from specific industries and exchanges
• A list of advancing stocks from specific industries and exchanges
• A list of declining stocks from specific industries and exchanges

• Select Details to view quote details 
for this company.

• Select Remove to delete this stock 
from your portfolio

• Select Move To Top to rearrange the 

Use the scroll bar to 
view the stocks added 
to your portfolio.
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Sports
The Sports application gives you the latest news, schedules, standings, and team 
information for seven different types of sports, including:

• National Football League (NFL)
• National Basketball Association (NBA)
• Major League Baseball (MLB)
• National Hockey League (NHL)
• National Collegiate Athletic Association (NCAA) Basketball and Football
• National Association for Stock Car Auto Racing (NASCAR), including the 

Nextel Cup series, Busch series, and Craftsman Truck series
• Major Golf News Stories

To view sports information:
Select Sports and select the sport you would like information about and select 
Next. With the exception of Golf News, you will be presented with the option to 
get News, Scores, league standings, or view a list of league teams (if available).

Select the type of information you would like and select Next. Once you have 
completed your request, Action Info will display a summary of your request. To 

Select Next to 
advance to the 
next screen.
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change any items, select the item you wish to change. If you are satisfied with the 
request, select Send.

Bid & Buy
Action Info gives you on-the-go access to eBay including:

• Browsing eBay Categories
• Searching by simple keyword or with advanced options
• Placing bids on items
• Viewing and managing your My eBay page

To browse eBay categories:
Select the Bid & Buy icon and select Browse by Category.

Action Info will display a list of the eBay categories.  Select the category you wish 
to browse.  If applicable, Action Info will display a list of sub-categories for you to 
choose.

Action Info remembers 
information from your 
previous requests.
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Once you have selected your categories, Action Info will display a summary of 
your request.   To change any items, select the item you wish to change. If you 
are satisfied with the request, select Send.

Action Info will return a list of items listed in your selected category.  To view the 
details of an item, select the desired item and Action Info will display the selected 
item’s page.

Select Next to 
advance to the 
next screen.

Select the name of 
the item you would 
like to view.
45 



Action Info User Guide – Application Descriptions

46
To search for a specific item:
Through Action Info, you can search for a specific item using a basic keyword 
search, or using an advanced search.

Select the Bid & Buy icon and select Search.  Choose either a Keyword Search or 
an Advanced Search

Use the scroll bar to 
view the rest of the 
information for this 
item.

Select View Images 
to see additional 
pictures of the item.

For more information on 
bidding on an item, 
refer to the To bid on an 
item section below.

Select Add to calendar 
to add the end date of 
this auction to your 
device’s calendar.

Select View description 
to see the full description 
of the item.

Select the seller’s name 
to see the seller’s 
feedback history.

Action Info remembers 
information from your 
previous requests.
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Enter a keyword or phrase to search for

Select whether you would like to search only the titles of the auctions or in both 
the title and description and select Next.  Select how you would like your results 
sorted.

If you selected to perform an advanced search, you will be prompted for the 
following as well:

• If you want to specify a price range in which to search
• If the auction offers Buy It Now
• If the auction requires PayPal

Select Areas for a list of eBay 
categories or enter the category 
in the text field.  To search in all 
categories, enter All.

Select Next to 
advance to the 
next screen.

Select the Don’t ask me 
again check-box and Action Info 
will remember your preference.
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Once you have selected all of your search parameters, Action Info will display a 
summary of your request.   To change any items, select the item you wish to 
change. If you are satisfied with the request, select Send.

Action Info will return a list of all items that match your search criteria.  To view 
the details of an item, select the desired item and Action Info will display the 
selected item’s page.

To bid on an item:
Action Info will allow you to place bids on item you wish to buy in eBay.

NOTE: By bidding on an item in eBay through Action Info, you are agreeing to a contract 
-- You will enter into a legally binding contract to purchase the item from the seller 
if you're the winning bidder. You are responsible for reading the full item listing, 
including the seller's instructions and accepted payment methods.

Once you have found the item you wish to bid on, select the Place Bid link on the 
item’s page.  Action Info will display the Place a Bid page with a list of pre-set bid 
amounts.  Select one of the bid amounts, or select Enter Bid Amount to enter a 

Select the name of 
the item you would 
like to view.
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different amount.

If you select one of the pre-set bid amounts, Action Info will display the following 
confirmation dialog box:

Select Yes to confirm your bid or No to cancel.  Action Info will prompt you to sign 
into eBay with your user ID and password.

NOTE: If you do not have an existing account with eBay, you must first go to eBay’s 
website and create an account.

Once you sign in, Action Info will place your bid and display the following dialog 
box:

To view your My eBay page:
eBay allows you to keep track of items you are watching or bidding on through 
your My eBay page.

Select the Bid & Buy icon and select View My eBay. Select Send on the request 
summary screen.
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Action Info will prompt you to enter your eBay User ID and password.

NOTE: If you do not have an existing account with eBay, you must first go to eBay’s 
website and create an account.

Select Next and choose whether you want Action Info to remember your login 
information or if you wish to enter it for each bid and buy request. 

Once you have entered your information, Action Info will display a summary of 
your request.   To change any items, select the item you wish to change. If you 
are satisfied with the request, select Send.
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Action Info will display your My eBay page.

Select the name of 
the item you would 
like to view.

Select the refresh 
icon to update your 
My eBay page.

Select the appropriate tab 
to view items you are 
bidding on, won, or lost.
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